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Introduction to Borland VisiBroker
For the CORBA developer, Borland provides VisiBroker for Java, VisiBroker for C++, 
and VisiBroker for .NET to leverage the industry-leading VisiBroker Object Request 
Broker (ORB). These three facets of VisiBroker are implementations of the CORBA 3.0 
specification.

VisiBroker Overview
VisiBroker is for distributed deployments that require CORBA to communicate between 
both Java and non-Java objects. It is available on a wide range of platforms (hardware, 
operating systems, compilers and JDKs). VisiBroker solves all problems normally 
associated with distributed systems in a heterogeneous environment.

VisiBroker includes:

–     VisiBroker for Java, VisiBroker for C++, and VisiBroker for .NET, three 
implementations of the industry-leading Object Request Broker.

–     VisiNaming Service, a complete implementation of the Interoperable Naming 
Specification in version 1.3.

–     GateKeeper, a proxy server for managing connections to CORBA Servers behind 
firewalls.

–     VisiBroker Console, a GUI tool for easily managing a CORBA environment.

–     Common Object Services such as VisiNotify (implementation of Notification Service 
Specification), VisiTransact (implementation of Transaction Service Specification), 
VisiTelcoLog (implementation of Telecom Logging Service Specification), VisiTime 
(implementation of Time Service Specification), and VisiSecure.
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VisiBroker Documentat ion

VisiBroker features

VisiBroker offers the following features:

–     “Out-of-the-box” security and web connectivity.

–     Seamless integration to the J2EE Platform, allowing CORBA clients the direct 
access to EJBs.

–     A robust Naming Service (VisiNaming), with caching, persistent storage, and 
replication for high availability.

–     Automatic client failover to backup servers if primary server is unreachable.

–     Load distribution across a cluster of CORBA servers.

–     Full compliance with the OMG's CORBA 3.0 Specification.

–     Integration with the Borland JBuilder integrated development environment.

–     Enhanced integration with other Borland products including Borland AppServer.

VisiBroker Documentation
The VisiBroker documentation set includes the following:

–     Borland VisiBroker Installation Guide—describes how to install VisiBroker on your 
network. It is written for system administrators who are familiar with Windows or 
UNIX operating systems.

–     Borland Security Guide—describes Borland's framework for securing VisiBroker, 
including VisiSecure for VisiBroker for Java and VisiBroker for C++.

–     Borland VisiBroker for Java Developer's Guide—describes how to develop 
VisiBroker applications in Java. It familiarizes you with configuration and 
management of the Visibroker ORB and with the programming tools. Also described 
is the IDL compiler, the Smart Agent, the Location, Naming and Event Services, the 
Object Activation Daemon (OAD), the Quality of Service (QoS), the Interface 
Repository, and the Interface Repository, and Web Service Support.

–     Borland VisiBroker for C++ Developer's Guide—describes how to develop VisiBroker 
applications in C++. It familiarizes you with configuration and management of the 
Visibroker ORB and how to use the programming tools. Also described is the IDL 
compiler, the Smart Agent, the Location, Naming and Event Services, the OAD, the 
QoS, Pluggable Transport Interface, RT CORBA Extensions, and Web Service 
Support.

–     Borland VisiBroker for .NET Developer's Guide—describes how to develop 
VisiBroker applications in a .NET environment.

–     Borland VisiBroker for C++ API Reference—provides a description of the classes 
and interfaces supplied with VisiBroker for C++.

–     Borland VisiBroker VisiTime Guide—describes Borland's implementation of the 
OMG Time Service specification.

–     Borland VisiBroker VisiNotify Guide—describes Borland's implementation of the 
OMG Notification Service specification and how to use the major features of the 
notification messaging framework, in particular, the Quality of Service (QoS) 
properties, Filtering, and Publish/Subscribe Adapter (PSA).

–     Borland VisiBroker VisiTransact Guide—describes Borland's implementation of the 
OMG Object Transaction Service specification and the Borland Integrated 
Transaction Service components.
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VisiBroker Documentat ion

–     Borland VisiBroker VisiTelcoLog Guide—describes Borland's implementation of the 
OMG Telecom Log Service specification.

–     Borland VisiBroker GateKeeper Guide—describes how to use the VisiBroker 
GateKeeper to enable VisiBroker clients to communicate with servers across 
networks, while still conforming to the security restrictions imposed by web browsers 
and firewalls.

The documentation is typically accessed through the Help Viewer installed with 
VisiBroker. You can choose to view help from the standalone Help Viewer or from 
within a VisiBroker Console. Both methods launch the Help Viewer in a separate 
window and give you access to the main Help Viewer toolbar for navigation and 
printing, as well as access to a navigation pane. The Help Viewer navigation pane 
includes a table of contents for all VisiBroker books and reference documentation, a 
thorough index, and a comprehensive search page.

Important

Updates to the product documentation, as well as PDF versions, are available on the 
web at http://www.borland.com/techpubs.

Accessing VisiBroker online help topics in the standalone Help 
Viewer

To access the online help through the standalone Help Viewer on a machine where the 
product is installed, use one of the following methods:

Windows

–     Choose Start|Programs|Borland VisiBroker|Help Topics

–     or, open the Command Prompt and go to the product installation \bin directory, 
then type the following command:

help

UNIX

Open a command shell and go to the product installation /bin directory, then enter 
the command:

help

Tip

During installation on UNIX systems, the default is to not include an entry for bin in 
your PATH. If you did not choose the custom install option and modify the default for 
PATH entry, and you do not have an entry for current directory in your PATH, use ./
help to start the help viewer.

Accessing VisiBroker online help topics from within the 
VisiBroker Console

To access the online help from within the VisiBroker Console, choose Help|Help 
Topics.

The Help menu also contains shortcuts to specific documents within the online help. 
When you select one of these shortcuts, the Help Topics viewer is launched and the 
item selected from the Help menu is displayed.

http://www.borland.com/techpubs
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Contact ing Bor land support

Documentation conventions 

The documentation for VisiBroker uses the typefaces and symbols described below to 
indicate the special text:

Platform conventions

The VisiBroker documentation uses the following symbols to indicate platform-specific 
information:

Contacting Borland support
Borland offers a variety of support options. These include free services on the Internet 
where you can search our extensive information base and connect with other users of 
Borland products. In addition, you can choose several categories of telephone support, 
ranging from support on installation of Borland products to fee-based, consultant-level 
support and detailed assistance.

For more information about Borland's support services or contacting Borland Technical 
Support, please see our web site at: http://support.borland.com and select your 
geographic region.

When contacting Borland's support, be prepared to provide the following information:

–     Name

–     Company and site ID

–     Telephone number

–     Your Access ID number (U.S.A. only)

–     Operating system and version

–     Borland product name and version

–     Any patches or service packs applied

–     Client language and version (if applicable)

–     Database and version (if applicable)

–     Detailed description and history of the problem

Convention Used for

italics Used for new terms and book titles.

computer Information that the user or application provides, sample command lines 
and code.

bold computer In text, bold indicates information the user types in. In code samples, bold 
highlights important statements.

[ ] Optional items.

... Previous argument that can be repeated.
| Two mutually exclusive choices.

Symbol Indicates

Windows All supported Windows platforms.

Win2003 Windows 2003 only

WinXP Windows XP only

Win2000 Windows 2000 only

UNIX UNIX platforms

Solaris Solaris only

Linux Linux only

http://support.borland.com 
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–     Any log files which indicate the problem

–     Details of any error messages or exceptions raised

Online resources

You can get information from any of these online sources:

World Wide Web
http://www.borland.com

Online Support

http://support.borland.com (access ID required)

Listserv

To subscribe to electronic newsletters, use the online form at:
http://www.borland.com/products/newsletters

World Wide Web

Check http://www.borland.com/us/products/visibroker/ regularly. The VisiBroker 
Product Team posts white papers, competitive analyses, answers to FAQs, sample 
applications, updated software, updated documentation, and information about new 
and existing products.

You may want to check these URLs in particular:

–     http://www.borland.com/products/downloads/download_visibroker.html (updated 
VisiBroker software and other files)

–     http://www.borland.com/techpubs (documentation updates and PDFs)

–     http://support.borland.com/entry.jspa?externalID=4273&categoryID=112 (VisiBroker 
FAQs)

–     http://community.borland.com (contains our web-based news magazine for 
developers)

Borland newsgroups

You can participate in many threaded discussion groups devoted to the Borland 
VisiBroker. Visit http://www.borland.com/newsgroups for information about joining 
user-supported newsgroups for VisiBroker and other Borland products.

Note

These newsgroups are maintained by users and are not official Borland sites.

http://www.borland.com
http://support.borland.com
http://www.borland.com/products/newsletters
http://www.borland.com/products/downloads/download_visibroker.html
http://www.borland.com/techpubs
http://support.borland.com/entry.jspa?externalID=4273&categoryID=112
http://community.borland.com
http://www.borland.com/newsgroups
http://www.borland.com/us/products/visibroker/
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Using the License Manager
You can use the License Manager to add, register, and remove your Borland product 
licenses. This section describes how to use the License Manager GUI features.

There are two types of Borland VisiBroker licenses:

–     Node-locked licenses. These licenses are locked to the system on which they are 
applied and activated. You cannot copy these licenses to another system, and they 
cannot be accessed from a VisiBroker product running on another system. If you 
reinstall the software on the same system, you will need to reactivate the license.

–     Network licenses. These licenses require the use of a license server. VisiBroker 
supports the use of Belise (Borland's license server). Refer to the instructions in the 
email you receive from Borland for activating and using your network licenses.

Starting the License Manager
The License Manager can be started from the VisiBroker Console:

1 Start the VisiBroker Console.

2 From the Tools menu, select License Manager.

The License Manager can also be started by running an executable:

Windows

–     To launch the License Manager on Windows, run the lmadmw executable found in the 
<install_dir>\bin directory.

UNIX

–     To launch the License Manager on UNIX, run the lmadm executable found in the 
<install_dir>/bin directory.

Viewing license information
The License Manager displays the licenses you have applied to products on the local 
machine. To see more detailed information about each license, click on the license 
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Adding l icenses

node in the left-hand navigation tree. The content pane on the right displays product 
details and operations that you can perform on the selected node.

Adding licenses
In some cases, you will need to apply multiple licenses to one installation. This will 
happen if you purchase optional products that can be added onto a base product. 
Applying a second, third, etc license to the same product installation is similar to the 
first.

Before you can add a new node-locked product license you will need the following:

–     The Serial Number and Key, or the activation file for each license. These will 
arrive in an email from Borland.

–     A Borland Developer Network (BDN) account. If you don't have an account, you 
will be able to create it during the registration/activation process.

–     Internet access. This is required if you want to use the Direct or Web page methods 
for activating your license. This can be from any system—not necessarily the system 
on which your product is installed.

To add a product license, complete the following steps:

1 Select Add from the Serial menu. The Add Serial Number dialog opens.

2 Enter the Serial Number and license Key, and click OK. The new serial number will 
appear in red letters in a list of Unregistered serial numbers in the License Manager 
navigation tree.

3 Select the New serial number, and select Register from the Serial menu. The 
Borland Product Registration Wizard steps you through the registration process. For 
more information about using the wizard see “Borland product registration wizard” in 
the Borland VisiBroker Installation Guide.

Importing licenses
In some cases, you will need to import a license from a file. To import a product 
license, do the following steps:

1 Select Import from the License menu. The Import License dialog opens.

2 Locate the license file using the Import License navigation tool, and click OK.

Removing licenses
To remove a product license, do one of the following operations:

–     Right-click on the license node in the navigation tree, and select Delete.

–     Select the license node in the navigation tree, and select Delete from the License 
menu.
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VisiBroker Console
The VisiBroker Console provides a graphical user interface that lets you examine the 
VisiBroker infrastructure that is running on your network. The VisiBroker Console can 
run on any machine from which users want to view or modify the distributed system.

Starting and logging onto the VisiBroker Console
To start the VisiBroker Console:

1 Launch the VisiBroker Console using one of the following methods:

Windows

–     From the Start menu choose Programs|VisiBroker|VisiBroker Console
or open a Command Prompt, and type the following command:

console

Note

To recognize the console command, your path system variable must include the 
<install_dir>\bin directory, or you can enter the path explicitly.

UNIX

–     Open a command shell and enter the following command:

console

Note

To recognize the console command, your path system variable must include the 
<install_dir>/bin directory, or you can enter the path explicitly.

The Administration Security Credentials screen appears.

1 Enter your User identity, Password, and Realm. 
To use the Borland default credential settings, enter the password:

admin



10 VisiBroker Overview

VisiBroker Console menus

2 Click OK. 
The VisiBroker Console appears.

VisiBroker Console menus
The VisiBroker Console provides the following main menus:

–     Console menu

–     View menu

–     Tools menu

–     Help menu

Console menu

The following table describes the commands in the Console menu.

View menu

The following table describes the commands on the View menu.

Tools menu
The following table describes the commands on the Tools menu.

Console menu command Description

Refresh Manually causes state information shown in the VisiBroker 
Console to be updated.

Preferences Opens the Preferences dialog box which you can use to set 
VisiBroker Console and configuration settings. See “Setting 
VisiBroker Console preferences” for information about setting 
preferences in this dialog.

Set Identity Sets the credentials (User identity, Password, and Realm) used for 
authentication during hub and agent discovery.

Exit Dismisses the VisiBroker Console.

View menu command Description

Messages Shows or hides the errors window.

Tool Bar Shows or hides the tool bar at the top of the VisiBroker Console 
window.

Status Bar Shows or hides the status bar at the bottom of the VisiBroker Console 
window.

Tools menu command Description

VisiBroker Properties File Editor Opens an editor allowing you to edit the VisiBroker 
properties file.
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Sett ing Vis iBroker Console preferences

Help menu

This menu provides you with access to each of the online Help documents and the 
About screen for the VisiBroker Console.

The About screen contains tabs that display some important information about your 
Borland software.

Setting VisiBroker Console preferences
VisiBroker Console preferences enable you to specify configuration, operation, and 
appearance settings used by the VisiBroker Console.

To set VisiBroker Console preferences:

1 Start the VisiBroker Console and choose Preferences from the Console menu. The 
Preferences dialog box appears with a list of preferences grouped into the following 
categories:

–     General: controls user interface options and settings.

–     Security: provides properties relating to the administration and management of 
the security environment.

–     VisiBroker: controls user interface options for the VisiBroker Console.

1 Navigate through the tabs and select the preferences as desired.

2 When you have finished making your selections, click OK.

The following sections provide details on each set of preferences.

General preferences

The General preferences provide settings to control various VisiBroker Console user 
interface elements. This tab provides the following options:

–     Look and feel: Sets the display format and behavior of the VisiBroker Console 
windows. The available options are: Metal, CDE/Motif, Windows (Microsoft Windows 
platforms only), or Borland.

–     Tab memory: Specifies the view state information the VisiBroker Console uses. The 
following options are available:

–     Don't remember last visited tab pane: Tells the VisiBroker Console to open 
each node in the tree with the General tab displayed on the right.

–     Remember last visited tab pane by type: Tells the VisiBroker Console to open a 
node on the same type of tab (on a similar node) that was most recently viewed. 
For example, if the Properties tab is currently in view and you click on another 
node that has a Properties tab, the VisiBroker Console first displays the 
Properties tab for that node.

–     Remember last visited tab pane by type and name: Tells the VisiBroker 
Console to open a node that had been expanded earlier in the VisiBroker Console 
session to the tab that was last in view when that node was selected.

About screen tab Description

About Displays the VisiBroker Console version number and copyright 
information.

General System Information Displays various system configuration settings that VisiBroker 
has detected such as the operating system, Java version, Java 
vendor, Java Compiler, and so forth.

Java Properties Shows the Java virtual machine property settings in use by 
VisiBroker.
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Sett ing Vis iBroker Console preferences

–     Sound beep on errors:: If checked, the VisiBroker Console sounds an alarm when 
an error occurs.

–     Enable debug output: Tells the VisiBroker Console to report debugging information 
in the Errors pane at the bottom of the VisiBroker Console.

–     HTML Browser Setup: Specifies the path to the Web browser you wish to use with 
the VisiBroker Console. Use the Browse button to locate an installed Web browser.

Security preferences

The Security preferences provide settings relating to the administration and 
management of the security environment. This tab provides the following options:

–     Default realm: Specifies the name of the authentication realm used by the 
VisiBroker Console.

–     Default user: Specifies the user name used by the VisiBroker Console .

–     Enable Security: Determines how the VisiBroker Console handles security:

–     When checked, enables the VisiBroker Console to communicate with an agent 
regardless if it has security enabled or not. When the VisiBroker Console receives 
a request from an agent with security enabled, however, the VisiBroker Console 
must first pass the user's login credentials (realm, username, and password) to 
that agent for authentication before the VisiBroker Console can access services 
on that agent.

–     When this box is not checked, the VisiBroker Console will communicate only with 
agents that do not have security enabled.

VisiBroker preferences

The VisiBroker tab is used to specify user interface options for the VisiBroker Console. 
This tab provides the following options:

–     Remove Stale Service Reference: Enable this option to remove all stale VisiBroker 
services references that were configured in the My Services folder of the VisiBroker 
Console main view.

–     Enable DNS Lookup: Enable this option to have the VisiBroker Console resolve any 
related DNS information to display in the Console. For example, the Console would 
display an IP address as its registered host name.

Note

Because any DNS lookup is an expensive resource operation, the VisiBroker 
Console provides this option to enable or disable DNS lookup.
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